NGGDPP Community
National Digital Catalog
User Guide

Quick Links

¢ Data Preservation Web Site

*  National Digital Catalog Search Page
*  Folder view of Contributing Agencies

Public Viewing

The National Digital Catalog resides as a Community within the USGS ScienceBase collaborative environment. The
community name is the abbreviation for National Geological and Geophysical Data Preservation Program (NGGDPP).

Search Page
The Search page for the NGGDPP Community can be found by following this link:

https://www.sciencebase.gov/catalog/?community=NGGDPP

This link should bring up a page similar to the following:
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From this page you can browse by Category, Topic, Location and use the simple or advanced Search capabilities.
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Folder View — Sorted by Title

An easy way to view a list of agencies contributing data to the NGGDPP community can be found by following this link:

https://www.sciencebase.gov/catalog/folder/4f4e4760e4b07f02db47dfb4?community=NGGDPP

science for a changing world

ceBase = NGGDPP Home  About

» Folders @ | Communities + NGGDPP

Title Date Modified

[Z2 Alabama Geological Survey 2012-02-29T15:42:26.9467
[£1 Alaska Geological Survey 2012-02-29T15:42:26.8062
[Z2 Arizona Geological Survey 2012-02-29T15:42:24.8467
[£1 Arkansas Geological Survey 2012-05-10T17:36:46.5192
[Z2 California Geological Survey 2012-02-29T15:42:26.9947
[=1 Collection of Geochemical samples from DC 2012-02-29T18:21:41.0502
£ Connecticut Geological Survey 2012-02-29T15:42:26.701Z
[ Delaware Geological Survey 2012-02-29T15:42:24.9472
[Z2 Florida Geological Survey 2012-02-29T15:42:25.8862
[£1 Idaho Geological Survey 2012-02-29T15:42:25.0042
[Z2 linois Geological Survey 2012-02-29T15:42:26.7852
[ Indiana Geological Survey 2012-02-29T15:42:25.0542

£ lowa Geological Survey
[£1 Kansas Geological Survey

2012-02-29T15:42:25.108Z
2012-02-29T15:42:25.157Z

[£2 Kentucky Geological Survey 2012-02-29T15:42:24. 7962
[£1 Louisiana Geological Survey 2012-02-29T15:42:25.2072
[£2 Maine Geological Survey 2012-02-29T15:42:25.2687
[£1 Maryland Geological Survey 2012-02-29T15:42:25.3182
[£1 Massachusetts Geological Survey 2012-02-29T15:42:25.9357
[£1 Michigan Geological Survey 2012-02-29T15:42:25.3682
£ Minnesota Geological Survey 2012-02-29T15:42:25. 4172
[£1 Missouri Geological Survey 2012-02-29T15:42:25.4662

£ Montana Geological Survey
[£1 Nebraska Geological Survey

2012-02-29T15:42:25.509Z
2012-02-29T15:42:25.563Z

£ Nevada Geological Survey 2012-02-29T15:42:25.614Z
[£2) New Hampshire Geological Survey 2012-02-29T15:42:25.6672
£ New Jersey Geological Survey 2012-02-29T15:42:25.704Z
£ New Mexico Geological Survey 2012-02-29T15:42:25.7342
£ New York Geological Survey 2012-02-29T15:42:25.779Z
[£1 North Dakota Geological Survey 2012-02-29T15:42:25.8292

1 2 Next

Search Here Deep/Mested Search Here [tern Summary/Details

This folder view shows the state contributors to the NGGDPP Community sorted in alphabetical order.

Clicking on any of these agency folders will open a new page showing a list of the Physical Collections currently registered
by each contributor. For instance clicking on the Arizona Geological Survey folder opens the following page:
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ScienceBase  About  Communi

'_ngI_d-ew Communities ~ NGGDPP - Kansas Geological Survey| © Access ~ |

[Search within this folder

Title

[= Collection of Drilling/completion reports from KS

[= Collection of Field notes from KS

[z Collection of Lithology logs from KS

[=1 Collection of Maps from KS

[=1 Collection of Paper reports from KS

[= Collection of Petrophysical Data from KS
[ Collection of Photographs from KS

[=] Collection of Production history from KS

[= Collection of Rock cores from KS

[=1 Collection of Rock cuttings from KS

[Z Collection of Routine analysis data from KS
[= Collection of Routine analysis data from KS

[Z Collection of Routine analysis data from KS
[= Collection of Scout tickets from KS

Date Modified

2012-02-29T718:21:50.814Z
2012-02-29T18:21:48.316Z
2012-02-29T18:21:36.8827
2012-02-29T18:21:50.491Z
2012-02-29T18:21:50.4252
2012-02-29T18:21:50.704Z
2012-02-29T18:21:36.6752
2012-02-29T18:21:37.530Z
2012-02-29T18:21:49.9152
2012-02-29T18:21:38.794Z
2012-02-29T18:21:36.904Z
2012-02-29T18:21:36.9962
2012-02-29T18:21:50.293Z
2012-02-29T18:21:37.1272

[ Collection of Surface & airborne data from KS 2012-02-29T18:21:50.390Z
[= Collection of Well logs from KS 2012-02-29T18:21:50.7622

Search Here Deep/Nested Search Here ltem Summary/Details

This page displays the current list of Collections registered in the National Digital Catalog by the referenced
agency. Clicking on a Collection Link will display a blank page if no items have been loaded for this collection:

ScienceBase About Communit

» Folders & | Communities + NGGDPP - Kansas Geological Survey - Collection of Maps fromKS 0 Access ~ | [Search within this folder
Title Date Modified

Search Here Deep/Nested Search Here ltem Summary/Details

If items have been loaded into this Collection a list of the individual items can be viewed:

| » Folders @ | Communities + NGGDPP - Kansas Geological Survey -+ Gollection of Rock cuttings from KS| o Access ~ | [Search within this folder
Title Date Modified

Kansas Geological Survey Rotary Cuttings, Sample Kid : 1005500412
Kansas Geological Survey Rotary Cuttings. Sample Kid : 1005500413
Kansas Geological Survey Rotary Cuttings. Sample Kid : 1005500414
Kansas Geological Survey Rotary Cuttings, Sample Kid : 1005500415
Kansas Geological Survey Rotary Cuttings, Sample Kid : 1005500416
Kansas Geological Survey Rotary Cuttings, Sample Kid : 1005500417
Kansas Geological Survey Rotary Cuttings. Sample Kid : 1005500418
Kansas Geological Survey Rotary Cuttings, Sample Kid : 1005500419
Kansas Geological Survey Rotary Cuttings. Sample Kid : 1005500420
Kansas Geological Survey Rotary Cuttings. Sample Kid : 1005500421
Kansas Geological Survey Rotary Cuttings, Sample Kid : 1005500422
Kansas Geological Survey Rotary Cuttings. Sample Kid : 1005500423

Kaneas Ranlnnical Quruau Ratan: Cuttinae Qamnla Kid @ ANNRRANA2A

2011-08-03T16:55:51.170Z
2011-08-03T16:55:52.5562
2011-08-03T16:55:53.590Z
2011-08-03T16:55:54.3592
2011-08-03T16:55:55.386Z
2011-08-03T16:55:56.338Z
2011-08-03T16:55:57.2892
2011-08-03T16:55:58.805Z
2011-08-03T16:55:50.8062
2011-08-03T16:56:00.879Z
2011-08-03T16:56:01.776Z
2011-08-03T16:56:03.1662
O 1-NA-NATHR-RR-NA ROAT

Clicking on these individual item records will bring up the individual item's metadata page. Note: Every item can
be viewed in a Folder or Item view.

By clicking the Title, found at the end of the breadcrumb-like links along the top of the display, the display can be
toggled between Folder and Item view.

Communities - NGGDPP - Kansas Geological Survey -+ Collection of Rock cuttings from KS
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The image above is a view of just the breadcrumb links at the top of each page. By clicking on “Collection of
Rock cuttings from KS” we can toggle between Folder and Item views. Clicking on the “Kansas Geological
Survey” takes you back to the agency's folder (or item) view depending on the current view.

Managing Your Data

By using the folder views above you should be able to navigate to your agency's folder and see all the currently
available collections. In this section we will cover:

*  Setting up a New User Account
* Editing a Collection Record
* Adding a New Collection

New User Account

You will need a login account on the myUSGS collaboration system to allow management of your records in the National
Digital Catalog. This account may be requested by sending an email to myusgs@usgs.gov with a request similar to the
following:

I am a Data Steward for a geophysical/geological collection which is part of the NGGDPP community. [
am requesting a myUSGS user account with permission to edit contents under my agency's folder.

My contact information is:

Agency Name:

Agency Contact Email:
Agency URL (optional):
User First Name:

User Middle Initial:
User Last Name:

User Email Address:
User Phone Number:

The MyUSGS support team will contact you directly with your login information. Once you have your username
and password you can login to the National Digital Catalog using the Login link in the upper right corner of each

page:

ZUSGS
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NGGDPP Home About  Communities Help

Editing a Collection Record

When you are logged into the National Digital Catalog system you will find an additional Manage button at the top of each
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l » Folders @ | Communities - NGGDPP - Connecticut Geological Survey| o Access ~ || ®mManage ~ |+ Add_~ [[Search within this foider |‘
Clicking on the Manage button displays the following drop-down menu: [ #Manage - ]
Click on Edit to display the Editing dialog. View History

Manage Permissions

This dialog is presents a number of tabbed screens to organize the information. You are Move
encouraged to fill in as much information as possible and to keep information current. Add Shortcut to ... N

Below is an example snippet of the basic editing form:

Edit: Collection of Rock cores from CT

U What U From U Who U When U Where ” How ” Tags U Files (1) U Extensions (1) ” External Sources
Title ? |Collection of Rock cores from CT
Folder ? Connecticut Geological Survey
I Look Up | Search for an item...
| selecttrom Tres |
Sub Title ?
Body ?
£
Continuous bedrock core from about 50 sites across CT. Stored in 1100 boxes.
This collection has been rescued three times since its formation in the late 1980's. Formerly administrative responsibility was shared between the
B inn Manl

Iniuareibu nf Mannacticid Mant nf Manlams and Mannhueire fnm dichandady and tha Mant ~f Enui I iral and Katural kictan,

Note: Additional information is available from the ScienceBase Help Documentation found at:

https://my.usgs.gov/confluence/display/sciencebase/ScienceBase

Uploading Item Metadata

The National Digital Catalog is in a state of transition at the moment so full details and capabilities are not yet finalized.
Contributing partners should upload the Item Metadata (.csv or .xml) files by including them as attachments to the
appropriate Collection record.

To do this follow the instructions above for Editing a Collection Record, and access the File tab on the Edit screen.
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ScienceBase NGGDPP Home About Communities Add Hem My ltems Help Admin reb@usgs.gov Logout

Edit: Connecticut Educational Hand Sample Collection

| What H From || Who || When H Where H How || Tags H Files (1) H Extensions (1) || External Sources
+ Add files...
Name Type Status
CT EHSC.csv text/plain stored ("Remove)
Force Scrape
Save @ Cancel © Delete ©
us. ment of the Interior | U.S. Geological Survey Accessibility | FOIA | Privacy | Policies and Netices
ScienceBase Version: 2.5 | Feedback | Support | Issue Tracking

Clicking the Add files... button from the Files tab will open a file browser for uploading a metadata file. By attaching the
file to the Collection we eliminate the need to specify a CollectionID in the metadata file and the file will remain a part of
the Collection for it's lifetime.

Many files can be added over time and associated with the Collection.

Once the new load capability is finalized, this file upload will trigger the sequence of events necessary to load the individual
items as child records of this collection. Included in this process will be the option of deleting the existing records or simply
appending the new items to the existing set of item metadata.

Adding a New Collection

A user must be logged in and have authorization to edit an Agency's folder before adding a new collection.

After logging in, navigate to your agency's space. For instance, in the screenshot below we have navigated the Connecticut
Geological Survey agency folder.

ZUSGS
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ScienceBase NGGDPP Home About Communities Add ltem My ltems Help Admin  reb@usgs.gov  Logout
» Folders @ = Communities + NGGDPP - Connecticut Geological Survey © Access ~ # Manage ~ . +Add ~ [S
Title Date Modified
=3 Collection of Rock cores from CT 2012-02-29T18:21:43.080Z % Manage ~
= Collection of Rock cuttings from CT 2012-02-29T18:21:43.294Z | @ Manage -
Connecticut Educational Hand Sample Collection 2012-05-17T19:17:50.2652 = Manag.a Bl
= NGGDPP Connecticut GS Harvested ltems 2012-02-29T15:42:26.7347 # Manage ~ .

m Summal

Search Here Deep/Nested Search

us. ment of the Interior | U.S. Geological Survey Accessibility | FOIA | Prvacy | Policies and Notices
ScienceBase Version: 2.5 | Feedback | Support | Issue Tracking

Note: Every new item must be a “child” of an existing “parent” item. In this case we want to add all of our collections as
children under the agency's folder. By navigating to the correct agency folder first we eliminate the need to select this
parent during the creation process — as the current item is used for the parent by default.
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To begin the creation of a new Collection, lick on the Add Item link found along the top menu bar.

The New Item form starts with the choice of creating the item from an Import File or Creating a New Record as shown in
the following screenshot:

ScienceBase NGGDPP Home  About Communities Add ltem My ltems Help Admin reb@usgs.gov Logout

New ltem:

How would you like to create this item?

Import File Create New Record

Click on the Create New Record button to open up the New Item metadata form. This form is identical to the Edit Form
accept the addition of the New Item tab which allows input of the minimal information necessary to create an item which
include a Title and Destination (or Parent).

ScienceBase NGGDPP Home  About Communities Add [tem My ltems Help Admin reb@usgs.gov Logout

New Iltem:

‘ New Item ” What ” From ” Who ” When ” Where H How ” Tags ” Files (0) ” Extensions (0) ” External Sources

Enter a Title: ?

Pick a Destination:  ? Connecticut Geological Survey

Connecticut Geological Survey

Look Up

Select from Tree [Cs Communities
[ System
Eq Users

Save @

If you had already navigated to the correct Parent/Destination folder before clicking on the Add Item link, the destination
will already be populated. In this case our destination is the Connecticut Geological Survey agency folder.

You must input the Title before saving the item. For consistency, we originally followed the form “Collection of [type]
from [2-letter state code]” in creating titles from the original inventory survey records. This is descriptive enough any many
cases. But you are free to use whatever title you believe will convey to a user the significance and uniqueness of a
particular collection.

Once you've entered the Title you may save the item but there is more work to do to adequately document the collection.

Continue editing the item making sure to fill out as much information as possible. In particular, fill out any information you
can in the What, Who and Where tags.

Then use the Extensions tab to add metadata that is unique to the National Digital Catalog. This information was
previously collected in the NGGDPP State Collections Inventory. To do this step, select NGGDPP Collection from the
Choose extension... selection box found on the Extensions tab.
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New ltem:

New Item U What U From U Who u When U Where H How U Tags H Files (0) U Extensions (0) External Sources

Add Extension |

NGGDPP Collection |5

\Save|

Once you have selected NGGDPP Collection from the select box. Click on the Add Extension button.

This will add a number of additional input fields which will allow you to add metadata unique to the National Digital
Catalog.

New Item:

New Item U What U From U Who U When U Where U How U Tags U Files (0) U Extensions (1) | Extemal Sources |

NGGDPP Collection Collection Categories:

Remove

New Category

Primary Purpose
New Primary Purpose

Collection Types:

Collection Size: Find/Select an unit.. E\

Usage Trend:

Collection Growth:

Needed Improvements:

NGGDPP Collection |5

Add Extension

ISave

Buttons found on the NGGDPP Collection form allow the addition of many attributes. Click on the corresponding buttons
to add as many Category, Primary Purpose, Type and User Group values as needed. Continue to fill out the remainder of the
information.
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Betty Adrian

Acting Program Coordinator,

National Data Preservation Program, Informatics, and Laboratories
U.S. Geological Survey

Box 25046, Mail Stop 975

Denver, CO 80225

Phone: 303-202-4828

Blackberry: 303-250-9340

FAX: 303-202-4856

e-mail: badrian@usgs.gov

Natalie Latysh

U.S. Geological Survey

Core Science Systems - Core Science Analytics and Synthesis
Phone: 303-202-4637 / 303-803-6426

E-mail: nlatysh@usgs.gov
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